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WORKSHOP INTRODUCTION 

WELCOME 

This hands-on workshop will familiarize you with some ArcGIS Pro terminology and prepare you to 
efficiently complete many different tasks related to mapmaking, data editing, data managing and 
analysis.  
 
In this workshop, you may learn how to migrate off a software that we have been using for a long time 
and to migrate your work in ArcGIS Pro. You can use many items that you originally created in ArcMap 
without converting those items. You will see how you can author web maps, web layers, and other items 
and then share them on the web.  

COURSE GOALS  

After completing this course, you will be able to perform the following tasks:  
1. Edit local and cloud data using ArcGIS Pro  
2. Modify schema of file databases 
3. Create, edit and deploy ArcGIS Pro Tasks (At the time of Printing) 
4. Share layers to a (small p) portal 
5. Better understanding of the new model format 

HONEST DISCLAIMER 

 
I steal things. Most of this workshop was found from searching the internet Converting PDFs into PPT & 
Word Documents. I did not pay for any of this material and I am not being paid to give the training. I 
work for an Esri business partner, but I am not a certified Esri instructor, nor claim to be any kind of 
expert. This is NOT an Esri training Session! Esri is the obvious benefactor of this workshop, if they give 
me a hard time for promoting their software, I’ll be back next year giving a workshop on QGIS.  

LINKEDIN BIO:  

The Geospatial field has been my profession since 2001; working at four different employers and 
having had several different positions within those organizations all GIS related. I have taught night 
classes at two separate colleges in my area over the course of ten years. This is a vocation for me, not a 
contest. 

 My own limitations are obvious to me and I constantly push myself to overcome them. I have a 
growing distaste for professional comparisons, people who always have to be right, or have an inherent 
distrust of their co-workers. These attitudes are cancerous.    

I promise to do the job at hand with my best efforts and judgement with humble consideration 
of existing long-term institutional knowledge. The GIS world is constantly changing, as is everything.  
Understanding and mitigating these changes can make or break the success of a project. I honestly 
believe that a properly running GIS can help organizations make better decisions. I strive to make each 
client successful as if it were my own system. 
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THE ARCGIS PLATFORM 

This portion taken directly from Esri Website: ArcGIS is a Web GIS platform that you can use to deliver 
your authoritative maps, apps, geographic information layers, and analytics to wider audiences.  

1. Individuals interact with ArcGIS through apps 
running on desktops, in web browsers, and on 
mobile devices.   

2. Organizations share their authoritative 
geospatial data, maps, and tools as web 
services to a central portal that supports self-
service mapping, analytics, and collaboration. 
Organizations deploy portals in the cloud, in 
their own infrastructure, or in both.   

3. Individuals use ArcGIS apps and portals to find 
authoritative content, create web maps and 
web apps, perform analytics, and share 
results.   

4. Organizations leverage the information shared by individuals to make more informed decisions, 
communicate with partners and stakeholders, and engage the public.   

5. A portal is a collaborative space where users can create, analyze, organize, store, and share 
geospatial content. Within ArcGIS there are two ways to implement a portal: use ArcGIS Online 
or deploy ArcGIS Enterprise.   

 

REASONS FOR MOVING TO ARCGIS PRO 

How does working with ArcGIS Pro differ from working with ArcMap?  
• Interface differences  
• Where tools are located (better search)  
• More and new functionality  
• Faster (supposedly)  
 
What are some reasons to migrate to ArcGIS Pro?  

• 64-bit, multithreaded application, which provides much faster display and processing.  
• Direct and Easy Integration with ArcGIS Online & Portal 
• Share resources and use shared resources directly from ArcGIS Pro.  
• Project-based application rather than document based.  
• Multiple layouts available in projects. 
• Attribute Rules!! 
• Context-sensitive interface and tab structure reduces clutter of many tools and toolbars.  
• Display, edit, and analyze 2D and 3D in the same application.  
• Seamlessly use ArcMap resources, such as scripts, models, and map documents.  
• All new Esri Development rolled out in Pro 
• Manage distributed data using geodatabase replication workflows to create and manage 

replicas and sync changes using traditional versioning 
• Metadata automation 
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INTRODUCTIONS 

Go to bit.ly/wlia2020pro 

 
Please take the time to fill out this quick survey, We will be accessing these feature layers later in the 

workshop.  

ESRI GIS BIBLIOGRAPHY  

A comprehensive index of journals, conference proceedings, books, and reports related to GIS, including 
references and full-text materials. gis.library.esri.com  
 
ArcGIS documentation and tutorials  
In-depth information, tutorials, and documentation for ArcGIS products. ArcGIS Online: arcgis.com 

ArcGIS Desktop: desktop.arcgis.com ArcGIS Enterprise: enterprise.arcgis.com  
 
GeoNet  
Join the online community of GIS users and experts. esri.com/geonet Esri events  
Esri conferences and user group meetings offer a great way to network and learn how to achieve results 
with ArcGIS. esri.com/events  
 
ArcGIS Ideas 
They actually look at these to determine vision, direction and tools to work on. Upvote ones you like and 
leave thoughtful ideas here. Tweet them out to get more votes; tag #WLIA, #GISTalk or #EWUG 
 
Esri Videos  
View an extensive collection of videos by Esri leaders, event keynote speakers, and product experts. 
youtube.com/user/esritv MANY ArcGIS Pro Videos Here 1-3- min apiece  
 
ArcGIS for Personal Use  
Improve your GIS skills at home and use ArcGIS to enhance your personal projects. The ArcGIS for 
Personal Use program includes a 12-month term license for ArcGIS Desktop, extension products, and an 
ArcGIS Online named user account with 100 service credits.  
esri.com/personaluse   
 
GIS Dictionary  
This term browser defines and describes thousands of GIS terms.  
http://support.esri.com/other-resources/gis-dictionary     
 
Terminology Guide 
Essential Terminology or Functionality That’s New to ArcGIS Pro  
https://www.esri.com/library/brochures/pdfs/arcgis-pro-terminology-guide.pdf  
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ArcGIS Pro Roadmap 
https://community.esri.com/docs/DOC-14549-arcgis-pro-roadmap-february-2020  
 
ArcGIS Deployment Tool 
The ArcGIS Solutions Deployment Tool is an ArcGIS Pro Add-in that allows you to browse a catalog of 
ArcGIS Solutions and deploy them to an ArcGIS Online organization or Portal for ArcGIS. 
https://solutions.arcgis.com/shared/help/deployment-tool/  
 
 
Please note for ALL the Demonstration and Screen captures instructor data is in C:\DataPro 
 

EX 1: QUICK   OVERVIEW 
 

CREATE A NEW PROJECT 

1. Start ArcGIS Pro  application. 
2. Name the Project  TazNG911 
3. Use the File folder icon to browse to the Location <Where ever you want>\Projects  as  

shown  in the graphic below. 

    

TABS/RIBBONS 

Project Tab 
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Map Tab 

 

Insert Tab 

 

Analysis Tab 

 

View Tab 

 

Edit Tab 

 

Share Tab 
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IMPORTING AN EXISTING MAP 

For the remaining portion of this workshop on ArcGIS Pro, you will be working with some data for the 
Tazewell County NG911 project in Illinois. This data was selected randomly and is only being used to 
highlight certain capabilities of ArcGIS Pro. No personal data is available.  

 

1. On the Insert Tab on the ArcGIS Pro application ribbon, 
click on Import Map. 

 

2. On the Import dialog, navigate to C:\DataPro\ and 
select the WLIAMXD1.mxd map document. This document was created using ArcMap 
10.7.1. 

 

3. Click Select to import the map document. 
 

You should now see a map displayed in a tab named Central. Your map will be displayed with the 
Contents panel that shows the contents of the Central map. If the Contents panel is not visible, you can 
activate it from the View tab on the application ribbon. 

Sometimes ArcGIS Pro imports things differently from what you might think.  

Compare Styles and Bookmarks 

4. On the Catalog Pane, Under the Project tab, expand the 
Styles. You will see there is no imported style from the 
ArcMap project which was here:  
 
 

5. From the CONTENTS Double Click one of the Custom Building icons, this will open the 
Symbology Tab. 

• Hover on the BUILDING style, see where ArcMap Imported the *.style to a 
*.stylx 

• You could also import the *.style to the Styles folder of the Project.  
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6. On the Map tab, click the down arrow 
on the Bookmarks icon to expand the 
bookmarks dialog. 

 
• See that the Bookmarks do 

import directly into the 
interface.  

 
 

 

MODIFYING A MAP IN ARCGIS PRO 

LABELING YOUR MAP 

Now you are going to modify some labels on your imported map that used the Maplex Labeling engine 
with an expression. 

1. Select the Road Centerline layer in the Contents panel 

2. Activate the Labeling tab on the ArcGIS Pro Application Ribbon. 

Note: that the properties set in the Labeling tab are specific to the selected layer in the Contents panel. 

 

3. Set the text style to POI (white Halo) 

4. Notice that the Expression can be modified in VBScript, 
Python or Arcade.  

5. Make sure the Remove Extra Spaces checkbox is 
selected, this will allow for features with missing fields in 
your expressions.  

6. Choose ‘European Streets’ for the label placement and 
notice how many more streets are labeled  
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EDITING DATA 

ArcGIS Pro allows editing tasks with the following traits: 
• The Edit ribbon contains most functionality 
• The Edit session is the default session, in other words editing is always “on” for all editable 

layers, you never need to start/stop editing or specify the edit target. 
• Snapping is activated by a button at the bottom of the map display (not a toolbar). You set 

snapping options with the button. 
• The Create pane contains all feature templates and tools for feature creation. 
• Edits can be saved or discarded either manually or automatically. 
• You can use group feature templates to create features in many layers at one time. 

If you have never edited in ArcGIS Pro, this will give you the opportunity to do some simple edits and 
experience the interface. If you’re experienced, then this will give you a change to play with data you 
don’t care about.  

1. In the map tab, drop-down bookmarks and select ‘New Housing’ You will see 
that there are some address points without building footprints  
 

2. Click the Edit Tab, then click “Create”. Select the buildings 
layer and create building footprints underneath points that 
do not have one already (no need to worry about what they 
look like). You might like the ‘Right Angle’ tool  

 
3. Note* Before you are able to see any edits to an Address point layer of its 

attributes, you may need to make it selectable from the Contents Pane.  
 
 

4. Save any edits. (Edit tab) 
 

 This is required In  order to make 
schema changes in the next 
exercise.  
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EX 2: DATA MANAGEMENT 
 

EDITING A SCHEMA 

In ArcGIS Pro, you can add, fields to a table, create new feature classes, domains, and use subtypes to 
categorize your data. Recently Attribute Rules got a big boost in functionality. In ArcGIS Pro, 
environments called Designers allow you to perform these tasks. The concepts of schema editing are the 
same as ArcMap, only the methods you will use have changes. Subtypes and attribute rules are still a 
feature class property, and domains are still a geodatabase property, but they are created from a 
different location in ArcGIS Pro. 

DOMAINS AND FIELDS 

For this exercise, we need to use a different database provided from the workshop. 

1. Under the View tab select Catalog view 

*Note: you may need to and a folder in order 

to Navigate to the other workshop data. 

2. Navigate to the NG911TAZ_WITH  workshop 

database.  

3. Expand the NG911TAZ_WITH Doc GDB Geo database. Option here is to open the Domains 

from the context menu. Do that 

4. The two options here are to create a new domain OR choose to see domain usage. 

 

5. Select Domain usage.  

6. This will open a tool to show what feature 

classes or tables use a specific domain 

within a given workspace.  

7. Exploring the different domains in this 
database, you can see that you still cannot RE- 
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order Domain but you can copy/paste into a domain from a spreadsheet.   
 

8. Again, Use the Catalog view Drill down to see the feature classes in the contents pane.  
 

9. In the Catalog View Right click on ESB_FIRE choose  

Design —> Fields 

10. Select and delete the {ServiceURI} and {ServiceURN} 
fields. (Row 1st cell should highlight green) 
 

11. Save and rows will disappear 

12. Now with the same process, Add a field to the 
AddressPoints feature class as outlined below  

 

13. Save.  

Also: From this view you can Edit field names, Alises, Domains, default values and length, but 
no reordering of fields, that’s a limited function of most databases 

ATTRIBUTE RULES  

1. In the Catalog view right click on AddressPoints and choose design —> attribute rules. 

Note* All Attribute uses currently need to be written in Arcade expressions.  

2. Explore the examples of existing rules.  We are going to create an attribute rule that will 

completely concatenation the mailing address into one single field.  

3. Open the “OSSI Full Address” rule and copy the expression.  

4. Click on Add Rule and name/describe it whatever you want  

5. Apply it to all subtypes and choose the new field you created above.  

6. Click on the green X to open the expression dialogue box.  

7. Paste the Arcade code from the the “OSSI Full Address” rule  above 

8. Add/modify the following lines to the expression above the last ‘return Concatenate’ line to 

look like the image below.  
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9. Check the Trigger of Insert and Update 

10. Save your rule.  

11. Since this feature class is not in the 

original imported map, (remember it was 

a different geodatabase) under the 

Catalog view, right click on the address 

points layer and add to new map. 

12. Zoom in to any Location in the map 

where points are visible 

13. Switch to the Edit Ribbon, Select and 

move a point to enact the attribute rule. 

ID the point to see the results. 

 

 

Note* GlobalIDs need to be enabled on 

the database feature class you are 

adding an attribute rule to.  

 

 

 

 

Well Done! 
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EX 3: CREATING MODELS AND SCHEDULING TOOLS 
 

MODELBUILDER 

 
You can add geoprocessing tools, data, and other elements, connect them to each other, and 
modify the elements' size and position. Essentially works just like the Old one but better. The 
Following is from ArcGIS Help online: 

ADD DATA 

You can add data to a model by dragging and dropping data and layers from the following 
panes: 

- Drag and drop datasets such as feature classes, tables, and rasters into 
ModelBuilder from the Catalog pane. 

- Drag and drop map layers into ModelBuilder from the Contents pane. When working 
in ModelBuilder, the Contents pane lists layers from the last active map or scene. 

 
 

ADD TOOLS 

You can add tools to a model using the following techniques: 
• Start typing directly in ModelBuilder to open the Add Tools To Model dialog and search for 

a specific tool. Double-click the desired tool to add it to the model. 
• Use the Tools  menu in the Insert group of the ModelBuilder tab to search for a specific 

tool, and double-click the desired tool to add it to the model. 
• Drag and drop geoprocessing tools into ModelBuilder from the Geoprocessing pane. 
• Drag and drop geoprocessing tools into ModelBuilder from toolboxes in the Catalog pane. 
• Drag and drop geoprocessing tools into ModelBuilder from Geoprocessing History. 
See more Here:  
https://pro.arcgis.com/en/pro-app/help/analysis/geoprocessing/modelbuilder/what-is-
modelbuilder-.htm 
 

 In the interest of time we are only going to use ModelBuilder to select 
features along a street and export for publishing in the next exercise.  

1. From the Analysis ribbon open a news blank canvas.  
2. Drag over AddressPoints from the contents pane.   
3. Dropdown the Toolbox and search for “feature class to feature 

class” tool and add it to the canvas. You will notice that it adds 
the default geodatabase as the output. This is fine.  
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4. There is no Connector tool, just use the mouse cursor to 
connect items together  

Double click on the gray box to fill in the rest if the tool requirements and 
define an expression as outlined below.  

 

 

( St_Name = 'SPRINGFIELD' )  The output feature class can be anything.  

 

5. Here you could Validate or Run the tool. Rather 
we want to ‘Open’  from the Catalog pane.  
 

6. At the bottom of the Geoprocesing tool click 
the Arrow next to Run and Select “Schedule”  
 

7. This is an awesome new 
option at 2.5. Problem is: 
At the time of Printing, I 
can’t get it to work.  

 

8. So, lets just run the tool manually.  
 

9. Once you have the new feature class created, Right click 
on it in the Catalog pane and add to a new map.  

 
 
*Note*ArcGIS Pro has many more 
options in ModelBuilder  that are 
powerful new tools.  
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EX 4 PUBLISHING/SHARING 
 

1. Use Manage Portals to log into multiple portals at the same time.  
• Green checkmark icon indicates the active portal.  
• The key icon indicated which portal is your license.  

 

 
 

2. Add a portal by Using your email 
you registered to the workshop 
with as the username to login to 
ArcGIS Online: 

https://cloudpointgeo.maps.arcgis.com and  
WLIA2020 as the password.  

 
3. Set that portal as Active  
4. If it’s not open already open the new map with the 

addresspoints from Springfield Rd.  
5. ArcGIS Pro cannot publish Esri Basemaps so these need to be 

removed from the Map.  
 

6. From the Share ribbon, Choose to Publish a web 
layer.  

7. Fill out the General information for the web layer 
and share it with the WLIA 2020 group.  
  

8. Under Configuration, click the pencil to edit the 
feature properties and enable editing.  
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9. Choose to publish this layer in your Root 
(home) directory for easier access.  
 

10. Analyze and Publish the layer. You may 
get a warning about a feature template. This is 
safe to continue.  
 

11. Once the layer has published successfully. Open 
the Portal tab on the Catalog Pane 
 

12. By default Pro shows your home directory. You 
should see the layer you published above.  
 

13. Add this layer to a new map 
 

14. In the Table of Contents, Right Click on the 
newly hosted AddresPoints layer; go to Design 
à Fields.  
 

15. You can add/modify a hosted layer field from 
this pane but Domains, Subtypes & Rules are 
read Only.  

 
16. Click the Groups Your User (assuming you are using the one assigned above) is in a Group called 

“WILA 2020”  
 

17. Add the “WILA Dashboard Web Map” to 
your Project with a Right-Click   
 

18. Try to add a point using the create features tab.  You 
will get a Warning/Notification that you are now 
able to use Undo (with 2.5) on Feature layers.  

19. Click OK to continue and add a point to the map.  
20. You can add attributes to a new point or edit an 

existing point.  
(try the undo Function!)  
*Note you can tell the dropdowns of the survey 
translated into this editing form but not ‘Select One’  
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OTHER SHARING/PUBLISHING UPDATES 

 
In the interest of time and functionality these are some screen captures of tools used in 
Publishing to an ArcGIS Server install from Pro and not to Portal or ArcGIS Online.  
 

 From ArcGIS Pro you 
can Manage, Add and 
Validate your On 
Premise ArcGIS Server 
Data Stores. This is not 
possible with ArcGIS 
Online.  
 
 
 
 

 
After adding an ArcGIS 
Server Connection (not 
Portal)  you will notice 
there is actual little that 
you can Manage. This 
interface is mostly used 
for adding layers & 
services to a map.  
 

 
 
 
 
The first and best thing that ArcGIS Pro 
did (circa 2.3) was add the ability to 
Publish to a Server install with 
referenced data. This was completely a 
function of the user community’s 
influence on Esri.  
 
The Second is implementing shared 
instances.  
 
This allows a service not to consume 
resources until a call is made  
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ADDITIONAL TOPICS 

ARCGIS SOLUTIONS DEPLOYMENT TOOL  

To install the ArcGIS Solutions Deployment Add-In, complete the following steps: 
Note: 
ArcGIS Solutions will be deployed in the ArcGIS Pro active portal. 
 

1. Download the ArcGIS Solutions Deployment zip file. 
2. Close ArcGIS Pro before installing the add-in. 
3. Browse to the folder to which you downloaded the zip file to and extract its contents. 
4. Double-click SolutionDeployment.esriAddInX to run the installer. 
5. Click Install Add-In. After installation is complete, click OK 
6. Start ArcGIS Pro and create or open a project. 
7. On the Share tab, in the Deploy group, click ArcGIS Solutions. 
8. Double-click Sign in to ArcGIS organization in the Tasks pane. Once you have completed 

the step, click the Finish button to proceed to the next step. 
9. Double-click Deploy an ArcGIS Solution in the Tasks pane. Select an ArcGIS Solution and 

click Deploy. Once complete, click the green check mark next to the solution to review it in 
your ArcGIS organization. 

10. Click the Finish button once you have completed the step. 
11. Optionally, begin configuring the solution or Load your Own Data to meet specific needs in 

your organization. 

REPORTS 

To add a new report to a project, do the following: 
1. On the Insert tab, in the Project group, click New Report  to open the Create New Report 

pane.  Optionally right-click a layer in the Contents pane and click New Report  to open 
the pane and have the report's data source set directly.  

2. In the Create New Report pane, review or update Report Name and Data Source. 
3. Next to filter the data and specify the fields in the report.  
4. Set the data filtering by choosing an option from the Rows menu: 

• All rows—all data is used in the report. 
• Selected rows—only selected data is used in the report. 
• Filter by expression— only data defined by a custom query is used in the report. 

5. Click Next to optionally group data and add sorting rules. By default, grouping is ascending 
in order. Summary statistics (count, minimum, maximum, sum, mean, and standard 
deviation) can be added.  

6. Click Next to design the report template, styling, and page setup. Page setup options 
include page units, size, and orientation. Custom page sizes can also be created, or a page 
size can be selected from a printer.  

7. Click Finish to create the report view. 
 


